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1. Introduction 

This document provides instructions on deploying Altair Knowledge Studio and Knowledge 
Seeker products of version 2025.0 for all platforms and configurations. 

If you are upgrading from an older version, see Section 4: Release 2025.0 and Previous 
Versions. 

The Architecture White Paper is available upon request. 

2. Product Components (Overview) 

This guide covers deployment procedures for the desktop and server-based configurations of 
the following products: 

▪ Knowledge Studio 

▪ Knowledge Seeker 

▪ Knowledge Studio for Apache Spark 

Knowledge Studio and Knowledge Seeker include R and Python language integration features 
and SAS Language integration. If the intended users are going to use these features, R and 
Python software must be installed first.  

The product name and feature set activated for each product are defined by the license 
applied after the installation. 

2.1 Knowledge Studio and Knowledge Seeker 

The Standalone configuration of Knowledge Studio and Knowledge Seeker for 
Windows Desktop or Windows Server includes the following installation packages:  

▪ KS Workstation 

▪ KS Library for R 

▪ Altair SLC 

▪ Altair Analytics Workbench 

R and Python software are prerequisites. Installation instructions for the Standalone 
configuration are given in Section 7. 

The Client/Server configuration for Windows Server includes the following installation 
packages: 

Client side: 

▪ KS Workstation 

▪ Altair Analytics Workbench 
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Server side: 

▪ KS Server 

▪ KS Library for R 

▪ Altair SLC 

The Client/Server configuration for Linux includes KS Workstation, KS Server, and 
Altair SLC. KS Libraries for R and Python are built in the KS Server package. 

Prerequisite software: R and Python software must be installed on the server side if the 
end users require R or Python code integration features. 

The installation procedure for the client/server configuration is described in Section 8. 

2.2 Knowledge Studio for Apache Spark 

Knowledge Studio for Apache Spark™ is a data science platform integrated with Apache 
Spark technology to provide predictive analytics on large-scale distributed data structures 
- Hadoop HDFS, Amazon S3, and other storage types supported by Spark. 

For the prerequisites concerning the Apache Spark server and the storage cluster, see 
“Requirements for Knowledge Studio for Apache Spark” in Section 3.2. 

The Standalone configuration of Knowledge Studio for Apache Spark includes KS 
Workstation. For installation instructions, see Section 7. 

The Client/Server configuration for Windows or Linux includes the following 
installation packages: 

Client side: 

▪ KS Workstation 

Server side: 

▪ KS Server 

The installation procedure for the client/server configuration is described in Section 8. 
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3. Supported Hardware and Software Platforms 

3.1. Overview: Supported Operating Systems 

Altair Data Analytics products version 2025.0 are available in the standalone and 
client/server configurations for the following operating systems: 

KS Workstation 
(Standalone or Client) 

KS Server 

Windows on x86-64 platform 

• Windows 10 

• Windows 11 

• Windows Server 2016 

• Windows Server 2019 

• Windows Server 2022 

 

Windows Server on x86-64 platform: 

• Windows Server 2016 

• Windows Server 2019 

• Windows Server 2022 

Linux on x86-64 platform: 

• Red Hat Enterprise Linux 7, 8, and 9  

• CentOS 7, CentOS Stream 8 and 9 

 

➢ All products are supported only on 64-bit systems. 

➢ Knowledge Studio for Apache Spark requires Apache Spark server. System 
requirements for this product are described at the end of Section 3.2 below.  

3.2. System Requirements 

• Microsoft .NET Framework 4.6.2 (or higher) and 3.5 Service Pack 1 are 
required for KS Workstation. The KS Workstation installation package includes 
the web installer for Microsoft .NET Framework 4.6.2 and installs it unless the 
same or a higher version is already present. It also enables Microsoft .NET 
Framework 3.5 if it is not already enabled in Windows features. 

• Microsoft Visual C++ 2015-2022 Redistributable package is required for KS 
Workstation and KS Server. Both KS Workstation and KS Server installers 
include the web installer for Microsoft Visual C++ 2015-2022 Redistributable and 
installs it unless the same or a higher version is already present. 

• KS Workstation includes KS PDF Printer component, which enables the Copy to 
PDF functionality for exporting decision trees, charts, and reports to PDF. The 
printer uses Amyuni PDF Converter by Amyuni Technologies, Inc. 

http://www.amyuni.com/


 

7 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

The following are the minimum and recommended requirements for all configurations: 

1. Standalone Configuration 

KS Workstation 2025.0 – Standalone 

Minimum Recommended 

Windows 10 or 11 (64-bit) 

x86-64 CPU, 2 GHz 

4 GB RAM 

Disk space: 

• 4 GB for program files ** 

• 15+ GB for user’s projects 

Monitor resolution: 1152x864 

Windows 10 or 11 (64-bit) 

Quad-core x86-64 CPU, 2 GHz, or better 

8 GB RAM or more * 

Disk space:  

• 4 GB for program files **  

• 20+ GB for user’s projects 

Monitor resolution: 1680x1050 or better 

* The amount of RAM required for the Standalone configuration depends on the typical 
size of analytic datasets and the types of models to be built. If the users will be dealing 
with very large datasets and need help assessing the required amount of RAM, please 
email dasupport@altair.com. 
 
** If R and Python integration features are required, R and Python program files and 
packages may take additional 3 GB or more. 
 
 

2. Client/Server Configuration 

KS Workstation 2025.0 – Client 

Minimum Recommended 

Windows 10 or 11 (64-bit) 

x86-64 based CPU, 2 GHz 

4 GB RAM 

Disk space: 4 GB for program files 

Monitor resolution: 1152x864 

Windows 10 or 11 (64-bit) 

x86-64 based CPU, 2 GHz or higher 

8 GB RAM or more 

Disk space: 4 GB for program files  

Monitor resolution: 1680x1050 or better 

 

mailto:dasupport@altair.com
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KS Server 2025.0 

Minimum* Recommended 

Windows Server 2016, 2019, or 2022; Red Hat 
Enterprise Linux 7, 8, or 9; CentOS 7; CentOS 
Stream 8 or 9 

x86-64 based CPU, 2 GHz 

8 GB RAM 

Disk space:  

• 3 GB for program files 

• 10+ GB per user for users’ projects** 

Windows Server 2016, 2019, or 2022; Red 
Hat Enterprise Linux 7, 8, or 9; CentOS 7; 
CentOS Stream 8 or 9 

A multi-core x86-64 based CPU(s) with at 
least 8 cores in total, 2.5 GHz, or better ** 

16 GB RAM or more** 

Disk space:  

• 3 GB for program files 

• 15+ GB per user for users’ 
projects** 

 
 
** Note: System requirements for the server depend on the maximum number of users 
expected to be using KS Server concurrently. The KS Server performance also depends 
on the typical size of analytic datasets, on whether any other applications run on the same 
server, and other factors. To ensure that your product is compatible with your environment 
and delivers expected performance, please fill in the Installation Questionnaire. Contact 
your account representative or email dasupport@altair.com to request the questionnaire if 
necessary. 
 
If R and Python integration features are required, the prerequisite R and Python program 
files and packages may take at least 3 GB of disk space on the KS Server host, depending 
on the R and Python distributions of your choice. 

3. Requirements for Knowledge Studio for Apache Spark 

Knowledge Studio for Apache Spark is an application for data mining and predictive 
analytics on large-scale distributed data structures (HDFS, Amazon S3, etc.) via Apache 
Spark. 

The types of distributed storage supported by Knowledge Studio for Apache Spark are 
the same as those supported by Apache Spark. The product is supported for any Hadoop 
distribution satisfying the Apache Spark server requirements listed below. 

Examples of supported Hadoop distributions: 

• Cloudera Data Platform. All CDP versions compatible with Apache Spark 2.4, 
3.1, 3.3, or 3.5.1: See the requirements for CDS Powered by Apache Spark at 
https://docs.cloudera.com/  
 

mailto:dasupport@altair.com
https://spark.apache.org/
https://spark.apache.org/
https://docs.cloudera.com/
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• Databricks Platform on Azure and AWS clouds with Apache Spark 2.4, 3.1, 3.3, 
or 3.5.1. See Apache Spark on Databricks. See also the Databricks 
documentation for Azure and AWS at https://databricks.com/documentation. 

Note: Spark cluster configurations with dynamic allocation are not supported. 

System requirements for the Knowledge Studio software components are described at 
the beginning of Section 3.2 (see above). The following are the requirements for Apache 
Spark Server. 

 

Apache Spark server requirements 

➢ Apache Spark version 2.4, 3.1, 3.3, or 3.5.1 

o Cluster management system options: Standalone (native Spark cluster) or 
Hadoop YARN or Apache Mesos 

➢ Python version 3.7 or 3.10, 64-bit 

➢ The following Python packages: 

o Pandas:  the Python Data Analysis Library version 2.1.3 provides data 
structures and analysis tools for Python 

o NumPy:  the package for scientific computing with Python (version 1.26.0) 
o SciPy: the fundamental library for scientific computing (version 1.11.3) 
o Scikit-learn: tools for data mining and data analysis (version 1.3.2) 
o PyArrow: Python API of Apache Arrow 

➢ Jupyter Notebook version 6.5.5 

➢ JupyterHub version 4.0.8 

 
For Jupyter Notebook prerequisites and installation instructions, see 
https://jupyter.readthedocs.io/en/latest/install.html 
 
For JupyterHub prerequisites and installation instructions, see 
http://jupyterhub.readthedocs.io/en/latest/ 
 
Note: The use of JupyterHub as a multi-user Jupyter notebook server is strongly 
recommended. If you prefer not to use JupyterHub, you can use basic authentication 
implemented by other mechanisms and configure them according to your security, 
authentication, and file system access requirements. 

Examples of supported types of distributed storage clusters:  

➢ Amazon EMR 

➢ Microsoft Azure HDInsight 

➢ Custom clusters satisfying the above requirements for Apache Spark, cluster 
management systems, Python, and Jupyter. 

https://databricks.com/spark/getting-started-with-apache-spark
https://databricks.com/documentation
https://hadoop.apache.org/docs/current/hadoop-yarn/hadoop-yarn-site/YARN.html
http://mesos.apache.org/
https://www.python.org/
http://pandas.pydata.org/
http://pandas.pydata.org/
http://www.numpy.org/
https://www.scipy.org/scipylib/index.html
http://scikit-learn.org/
https://arrow.apache.org/docs/python/
http://jupyter.readthedocs.io/en/latest/install.html
http://jupyterhub.readthedocs.io/en/latest/
https://jupyter.readthedocs.io/en/latest/install.html
http://jupyterhub.readthedocs.io/en/latest/
https://aws.amazon.com/emr
https://azure.microsoft.com/en-us/services/hdinsight/
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For your convenience, our Customer Support can provide a script for installing the 
necessary prerequisites, including the required Python packages. The script is provided 
upon request. You can modify it as you see fit to install the components that you need. 
Please contact Data Analytics Customer Support at dasupport@altair.com to request the 
script. 
 
For the client/server configuration of Knowledge Studio for Apache Spark, the range of 
TCP ports 6060 – 6090 on the server must be open for inbound connections from the client 
machines. In the standalone (desktop) configuration, Knowledge Studio for Apache Spark 
also uses ports in this range, but this is confined to localhost.  
 
For more information on the security configuration settings: 

• for KS Server on Windows, see Section 8.1.4: “Configuring KS Service”. 

• for KS Server on Linux, see subsection “Configuring Server Security (Network and 
Firewall Settings)” in Section 8.2.5: “Configuring KS Server on Linux” 

 
 
 
 

  

mailto:dasupport@altair.com
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4. Release 2025.0 and Previous Versions 

▪ Version 2025.0 can be installed and run side by side with any previous version. 

▪ Uninstalling Altair Data Analytics products does not remove the users’ data, project files, 
working directories or licenses. 

▪ If you run version 2025.0 side by side with an older version for a period of evaluation or 
testing during the upgrade, use a separate working directory for each version, since older 
projects modified in 2025.0 may no longer be compatible with their original version. See 
Section 5 for details about the Working Directory. 

▪ Project compatibility: 

o Altair projects created in versions 9.3 – 2024.2 can be opened and modified in 
version 2025.0 without any conversion. 

It is recommended to make a backup copy of your old projects before opening 
them in version 2025.0. 

o Forward compatibility is not supported: models and other objects in projects 
created or modified in version 2025.0 may not be loaded correctly when opened 
in older versions. 

▪ KS PDF Printer compatibility: 

When using KS Workstation 2025.0 side by side with an older version, the error “Printer 
not activated, error code - 41” may occur when using the Copy to PDF command under 
the File menu. The solution is to reinstall both versions of KS PDF Printer by executing 
the following commands in Command Prompt started as administrator. For example, for 
versions 2025.0 and 2023.1, run the following commands: 

  cd "C:\Program Files\Altair Data Analytics\KS Workstation 2025.0.0\bin" 

  Install -s -u "KS PDF Printer"  

  Install -s "KS PDF Printer"  

  cd "C:\Program Files\Altair Data Analytics\KS Workstation 2023.1.0\bin" 

  Install -s -u "KS PDF Printer"  

  Install -s "KS PDF Printer" 

o Note: In case KS PDF Printer is removed from the system, it can be restored 
by running AngossPDFInstall.cmd from C:\Program Files\Altair Data 

Analytics\KS Workstation 2025.0.0\bin. 
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5. Prerequisites 

This section describes installation prerequisites for all configurations and platforms. 

5.1.  Overview 

▪ Ensure that your systems meet the hardware and software requirements. Note that 
the required hardware resources (CPU, memory) depend on the typical size of 
analytic datasets, the type of data mining tasks to be performed by the users, the 
expected number of concurrent users in the case of a server-based configuration. 

▪ Knowledge Studio and Knowledge Seeker features include integration with Tableau® 
and Qlik® - business intelligence software for interactive data visualization. Tableau 
integration features in Knowledge Studio and Knowledge Seeker require Tableau 
Desktop or any Tableau workbook viewer on the user’s workstation and, optionally, 
web access to a Tableau Server from the user’s workstation. Tableau components 
can be installed independently of Altair Data Analytics products. Supported Tableau 
versions are 2019.1 and higher. Altair does not distribute Tableau software or 
licenses for it. If you do not use Tableau but would like to know more about it, please 
visit http://www.tableau.com/. 

▪ R and Python language integration features require R Software for statistical 
computing and Python software. Install them if the end users need these features. 
The instructions are given below in Sections 5.2 and 5.3. 

▪ For configurations with multi-user access (client/server or shared standalone 
software on a server): 

o For the client/server configuration, TCP port 5470 must be open on the 
KS Server host for inbound connections from the client machines. 
Knowledge Studio for Apache Spark also uses TCP port range 6060-
6090. See Section 8.1.4 for details. 

You may also need to add KS Server and KS Workstation to the list of 
authorized applications if such a list is maintained for your antivirus or other 
security systems. 

o Each user must have a user account recognized by the host machine where 
KS Server is installed. 

o For each user, a working directory with sufficient space must be allocated for 
their projects. For example, server administrators can create a directory 
KS_Projects with subdirectories KS_Projects/<user_name> for each 

user. A single shared directory may be used for all users, but it is a less 
organized way. 

The Working Directory does not have to be on the application server that 
hosts KS Server. It may be on a network drive, as long as it is on a file 
system accessible from the application server and the read & write access to 
this storage is fast enough. In the case of a Windows Server, users can 
specify a UNC path for the Working Directory. Note that KS Server cannot 
access mapped drives in the client/server mode on Windows. 

http://www.tableau.com/
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The necessary space to allocate can be calculated based on the average 
size of analytic datasets (number of rows and columns), the number of 
datasets in each project, and the number of projects. Assign the appropriate 
Read & Write permissions for the created directories as required by your 
security policies. Note: Any user can change their working directory at any 
time after the installation using the Connect or Set Working Directory 
commands in the File menu of KS Workstation. 

o If users will be importing data from databases, ODBC drivers for the source 
databases must be installed on the server, and the users must have 
sufficient permissions on the server to load the drivers. 

▪ If you are using self-hosted Altair License Server, you will receive a license file and 
an installation guide for Altair License Manager. See Section 14.2 for details. 

5.2.  R Software for Statistical Computing 

Knowledge Studio and Knowledge Seeker support integration with the R language. R software 
must be installed as a prerequisite if the end users require the R integration feature. 

R versions 4.0 and higher are supported. 

Note: For the Client/Server configuration of Knowledge Studio and Knowledge Seeker, R is 
only required on the server side. 

5.2.1 R for Standalone and Client/Server Configuration on Windows 

R software is available at the R Project website http://www.r-project.org/.  

 

On the R Project page, click “download R” and select the preferred mirror site of the R 
Archive Network. On the next page click “Download R for Windows” 

https://www.r-project.org/
http://www.r-project.org/
https://cran.r-project.org/mirrors.html
https://cran.r-project.org/mirrors.html
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On the next page, click “Install R for the first time”: 

 

On the next page, download the latest version of R software. If you need an older version 
of R, click the Previous releases link on the same page. Note that R versions older than 
4.0 are not supported. 

Run the downloaded R installer. In the third page of the installation wizard, select at least 
the Main Files and 64-bit Files components. 
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Choose the remaining options as desired and finish the installation. 

5.2.2. R for Client/Server Configuration on Linux 

To install R on Linux, use the following examples of R installation steps. 

On RHEL 7 and CentOS 7: 

sudo yum update 

sudo yum install epel-release 

sudo yum install R 

On RHEL 8 and 9 or CentOS Stream 8 and 9: 

sudo dnf install epel-release 

sudo dnf config-manager --set-enabled powertools 

sudo yum install R 

The default R installation directory is /usr/lib64/R. To verify the installation, use the 

command  

R --version 

For more information on installing R on Linux, see the R project website https://www.r-
project.org/ and https://fedoraproject.org/wiki/EPEL  

5.2.3. Rserve Package for R   

The Rserve package (Binary R server) is required. It must be installed in the R library 
folder used by the R Code node in Knowledge Studio and Knowledge Seeker. By default, 
it is the common library location for R. On Windows, it is usually C:\Program 

Files\R\R-N.N.N\library, where N.N.N is the R version. On Linux, it is usually 

/usr/lib64/R/library. 

Make sure the common library location for R has Read and Write permissions for the 
intended user(s) or group. For example, for R version 4.3.2, it is C:/Program 

Files/R/R-4.3.2/library. For the client/server configuration, you may want to 

create a user group for KS Server users and assign the permissions to the group. 

Windows:  

Run the R console and install the Rserve package into the common R library 
location. The following example assumes that the R version is 4.3.2:  

install.packages("Rserve", "C:/Program Files/R/R-4.3.2/library") 

Linux: 

• If you are using Amazon Linux AMI, install or update openssl-devel using the 
command yum install openssl-devel 

https://www.r-project.org/
https://www.r-project.org/
https://fedoraproject.org/wiki/EPEL
https://cran.r-project.org/web/packages/Rserve/index.html


 

16 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

• Run R and install the Rserve package version 1.8-0 or higher. For example, to 
install Rserve from the repository https://rforge.net, use the following command 
from the R command line: 

install.packages("Rserve",,"https://rforge.net") 

The library location can be specified explicitly as follows: 

install.packages("Rserve","/usr/lib64/R/library","https://rforge.net") 

Refer to the R documentation for the install.packages and .libPaths commands, 

if necessary. 

5.3.  Python 

The Python Language Integration enables embedding Python programs into the visual 
workflows of Knowledge Studio and Knowledge Seeker projects. For more information on 
Python, see the Python project website https://www.python.org/.  

Prerequisites 

• The Python Code node feature requires Python version 3.7 or higher, Python Data 
Analysis Library (pandas), SciPy and NumPy libraries, and the reports package. 
Python versions 3.7 – 3.12 are supported. 

For the Client/Server configuration, Python is only required on the server side. On Linux, 
Python libraries should be installed for all users rather than in a local user directory. 

To enable Jupyter Notebook integration in the Client/Server configuration on Windows:  

• Set the following system environment variables on the server. Their values must be 
set to folders that have Read & Write permissions for all users of the application. 

o JUPYTER_CONFIG_DIR 

o JUPYTER_DATA_DIR 

o JUPYTER_RUNTIME_DIR 

• In the Windows Firewall on the server, open a range of TCP ports for Jupyter 
Notebook users (for example, 8800-8900) and inform each user of the port assigned 
to them for Jupyter Notebook use. 

5.4.  unixODBC and openssl for Linux 

The following prerequisites are required for KS Server on Linux: 

• unixODBC driver manager 

To install unixODBC, use the command 

    sudo yum install unixODBC 

https://rforge.net/
https://www.python.org/
https://www.python.org/
http://pandas.pydata.org/
https://www.scipy.org/
https://numpy.org/
https://pypi.org/project/reports/
http://www.unixodbc.org/
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To check the version of the installed unixODBC:  

    rpm -qa unixODBC 

• openssl and openssl-libs version 1.0.2 or higher 

To install the latest version, use the command 

    sudo yum install openssl openssl-libs 

6. Supported Installation Modes on Windows 

▪ To install an Altair Data Analytics product on a small number of workstations, run the 
downloaded MSI package on each workstation. This process is described below in the 
sections on deploying the standalone and client/server configurations. 

▪ To install the software in the silent mode from the command line without user interaction 
via the wizard, see Section 9.1, “Silent Install”. 

▪ The Altair Data Analytics software installer supports mass deployment on many 
workstations using automated installation tools. For example, macros can be specified in 
the installation wizard to customize the Working Directory location for individual users. 
See Section 9.2, “Customizations to Assist in Repackaging KS Workstation for 
Deployment”. 

▪ To deploy the product in a Citrix environment or use it with Remote Desktop Services, 
see Section 10. 
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7. Deploying the Standalone Configuration 

• The Standalone configuration can be used by a single user on Windows Desktop or 
by multiple users on Windows Server via Remote Desktop connection or Citrix. 

• KS Workstation is the main component of the Standalone configuration of 
Knowledge Studio and Knowledge Seeker for Windows Desktop or Windows Server. 
KS Library for R is required to enable R language integration features (see Section 
5.2.1), while Altair SLC and Altair Analytics Workbench are required for the SAS 
Language integration features in Knowledge Studio. 

• KS Workstation is the only component required for the Standalone configuration of 
Knowledge Studio for Apache Spark. For the Apache Spark server and Hadoop 
cluster requirements, see Section 3, Subsection: “Requirements for Knowledge 
Studio for Apache Spark”. 

7.1. Deploying KS Workstation (Standalone) 

1. Log in to the computer as a user with sufficient rights to install software. 

2. Double-click the downloaded MSI package KS-Workstation-2025.0-64bit.msi to start the 
installation. 

3. The installer prepares the InstallShield Wizard, and the Welcome window opens. Click 
Next >. 

 

4. The License Agreement window opens. If you accept the terms, select “I accept” and 
click Next >.  
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5. The Configuration Type window opens.  

▪ Select the “Standalone configuration” option if the software will be run in the 
standalone mode on this machine. 

 

Click Next >. 
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6. Specify whether you are the intended user. (This will define the default Working Directory 
at one of the next steps.) Click Next >. 

 

7. If necessary, change the destination folder for the application program files by clicking the 
Change button and specifying the desired location. The default is C:\Program Files\Altair 
Data Analytics. Click Next >. 
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8. The Working Directory window opens. Specify the path for the Working Directory for Altair 
project files. Make sure it has Read & Write permissions for the intended user(s). If 
necessary, click Change and create a new folder.  

Note 1: If you prefer to use cloud storage, such as OneDrive or Google Drive, select a 
folder with offline access enabled. For example, if you choose a folder on OneDrive, right-
click the folder in Windows Explorer and select option “Always keep on this device".  

Note 2: The Working Directory can be changed after the installation at any time using the 
Set Working Directory command or the Connect command in the File menu.  

 

Click Next > 

9. The License Configuration window opens.  

• If the host machine has already been configured for Altair licensing, the current 
values of the environment variables ALM_HHWU and/or ALTAIR_LICENSE_PATH 

are displayed. Click Next > to accept the existing configuration. 

Example 1: The machine is already configured for managed Altair Licensing 
(ALM_HHWU=True): 
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Example 2: The machine is already configured for an on-premises Altair License Server 
(ALTAIR_LICENSE_PATH=6200@<server_name>; ALM_HHWU=false): 
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• If the host machine has not previously been configured for Altair licensing, select 
Edit and choose the licensing method: Managed Altair Licensing or On-premises 
Altair License Server.  

Contact your team members responsible for Altair product licenses if you are not sure 
which licensing method you need to use. 

 

o If you select Managed Altair Licensing, click Configure to open Altair 
License Utility and authorize the machine using the options in the 
Managed Licensing tab. 
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Once you close Altair License Utility and click Next >, the system 
environment variable ALM_HHWU will be created, and its value will be 
set to True. 

 

o If you select On-premises Altair License Server, enter the license server 
address and port in the format <port>@<host>, for example, 

6200@server1.  
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Once you click Next >, the system environment variables 
ALTAIR_LICENSE_PATH and ALM_HHWU will be created. The former will be 

assigned the value you specified, and the latter will be set to False. 

See Section 14 for detailed information about the licensing methods. 

10.  At the final step:  

▪ Choose whether to install the desktop shortcut. 

▪ The option to install KS PDF Printer is selected by default. It enables the function of 
saving decision trees, tables, charts, and reports as PDF. Leave it selected unless 
you are already using a PDF printer driver or converter of the same brand. 

Click Install to start the installation. 

  

11. The Setup Status window shows the installation progress. When the installation is 
complete, choose whether to launch the software now and click Finish. 
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The installed software is now available in the Windows Start menu. Launch the application by 
double-clicking the desktop shortcut KS Workstation 2025.0.0 or selecting Start | All 
Programs | Altair Data Analytics | KS Workstation 2025.0. 

 

See Section 14 for detailed information about the licensing methods. 

 

NOTE: The KS Workstation installer enables Microsoft .NET Framework 3.5 if it is not already 
enabled in Windows features. If the installer fails to enable it, download the offline installer 
from the Microsoft website https://learn.microsoft.com/en-us/dotnet/framework/install/dotnet-
35-windows. 

7.2. Advanced Configuration Using KDSConnection.ini 

After installing KS Workstation, you can change the initial settings for the mode (Standalone or 
Client/Server) and the Working Directory using the file KDSConnection.ini in C:\Program 

Files\Altair Data Analytics\KS Server 2025.0.0\bin. 

Example content of KDSConnection.ini: 

<Config> 

<Mode>0</Mode> 

<Location>C:\Analytic Workspace\</Location> 

<Service></Service> 

<User></User> 

<Host></Host> 

<Port>5470</Port> 

<Secure>True</Secure> 

</Config> 

https://learn.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows
https://learn.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows
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For example, to change the mode from Standalone to Client/Server, specify 1 for Mode, 
specify the user ID, the KS Server host name or IP address, and the port number in the 
appropriate lines as shown in the example below:  

<Config> 

<Mode>1</Mode> 

<Location>C:\Analytic Workspace\</Location> 

<Service></Service> 

<User>jsmith</User> 

<Host>ks_server</Host> 

<Port>5470</Port> 

<Secure>True</Secure> 

</Config> 

7.3. Installing KS Library for R Integration 

Knowledge Studio and Knowledge Seeker support integration with R software for statistical 
computing. If the end users require this feature, install KS Library for R as described below. 

In the Prerequisites section above, see Section 5.2: ”R Software for Statistical Computing”. 
The Rserve package is required (see Section 5.2.3: “Rserve Package for R”).  

1. Make sure KS Workstation 2025.0 and R v4.0.0 or higher are installed. 

2. Download KS Library 2025.0 for R 4.0 or higher from the Altair Knowledge Studio 
Downloads page. 

3. Uninstall any previous version of KS Library for R from the Programs and Features list 
in the Windows Control Panel. 

4. Double-click the downloaded installer file. Click Next > in the Welcome screen. 

 

https://www.r-project.org/
https://www.r-project.org/
https://cran.r-project.org/web/packages/Rserve/index.html
https://altairone.com/Marketplace?queryText=Knowledge+Studio
https://altairone.com/Marketplace?queryText=Knowledge+Studio
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5. In the License Agreement window, select “I accept” if you accept the terms. Click 
Next >. 

 

6. The Destination Folder window opens. KS library for R will be installed into <R root 

folder>\R-X.X\library\, where R-X.X is the most recent version of R on the 

host machine. The standard R root folder is C:\Program Files\R. The default 

folder to extract the temporary setup files is C:\Program Files\Altair Data 

Analytics. To change any of these folders, click the Change button.  
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Click Next >. 

7. Click Install. 

 

8. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 
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As a result, three subfolders representing the required R integration libraries are created 
under <R root folder>\R-X.X\library\: 

• angoss 

• KnowledgeSurvival 

• xtable  

If you are going to use a different R library path, copy the folders angoss, xtable, and 

KnowledgeSurvival from <R program folder>\R-X.X\library\ to the desired R 

library location. 

Note: The Rserve package, whose installation was described in Section 5.2.3, must be 
present in the same R library location. 

7.4. Installing Altair SLC and Altair Analytics Workbench 

Knowledge Studio supports SAS Language. This functionality is powered by Altair SLC and 
Altair Analytics Workbench (formerly known as WPS Analytics). 

1. Download the latest versions of Altair SLC and Altair Analytics Workbench from AltairOne 
Marketplace. If you don’t have an AltairOne account, please reach out to the person 
managing Altair software licenses at your organization or contact Altair Data Analytics 
Customer Support at dasupport@support.com. 

2. Run the downloaded Altair SLC installation package. Click Next > in the Welcome screen.  

 

https://cran.r-project.org/web/packages/Rserve/index.html
https://altairone.com/Marketplace?queryText=SLC&tab=Info&app=Altair+SLC
https://altairone.com/Marketplace?tab=Info&app=Altair+Analytics+Workbench
https://altairone.com/Marketplace
https://altairone.com/Marketplace
mailto:dasupport@support.com
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3. In the End-User License Agreement window, select “I accept the terms in the License 
Agreement” if you accept the terms. Click Next >. 

 

4. In the Custom Setup page, select all Altair SLC program features, as shown below. To 
change the destination folder for the application program files, click the Change button 
and specify the desired location. The default is C:\Program Files\Altair\SLC\<version>. 
Click Next >. 

 



 

32 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

5. Click Install to start the installation. 

 

6. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 

 

7. Altair SLC provides the engine component (SAS language compiler) with no graphical 
user interface. Install Altair Analytics Workbench to access a GUI-based integrated 

https://altairone.com/Marketplace?tab=Info&app=Altair+Analytics+Workbench
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development environment for the SLC engine. Run the Altair Analytics Workbench 
installation package. Click Next > in the Welcome screen.  

 

8. In the End-User License Agreement window, select “I accept the terms in the License 
Agreement” if you accept the terms. Click Next >. 
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9. In the Custom Setup page, select all program features, as shown below. To change the 
destination folder for the application program files, click the Change button and specify 
the desired location. The default is C:\Program Files\Altair\Analytics 
Workbench\<version>. Click Next >. 

 

10. Click Install to start the installation. 
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11. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 

 

12. Altair Analytics Workbench is now available in the Windows Start menu. Launch the 
application by double-clicking the desktop shortcut “Altair Analytics Workbench” or 
selecting Start | Altair | Altair Analytics Workbench. 

 

Altair SLC and Analytics Workbench use the same license as Knowledge Studio and 
Knowledge Seeker. Activating these products with an Altair Units License automatically 
activates SLC and Analytics Workbench on the same machine. 

 

8. Deploying Client/Server Configuration 

For the client/server configuration, KS Workstation software must be installed on each client 
machine, and KS Server software must be installed on the server.  

R Statistical Software, Python software, and KS Library 2025.0 for R must be installed on the 
server if users need R and Python integration features.  

For SAS Language integration features, Altair SLC must be installed on the server, while Altair 
Analytics Workbench must be installed on the client machines.  

Note: TCP port 5470 must be open for inbound connections on the KS Server host. The 
application can be configured to use a different port if necessary. Additional ports need to be 
open for Knowledge Studio for Apache Spark. The details are provided in the sections below. 

Security protocols: In the client/server mode, TLS1.2 is used by default. The older versions 
TLS1.1, TLS1.0, and SSL are never used. 

http://www.r-project.org/
https://www.anaconda.com/
https://altairone.com/Marketplace?queryText=SLC
https://altairone.com/Marketplace?queryText=Analytics+Workbench
https://altairone.com/Marketplace?queryText=Analytics+Workbench
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Make sure all the installation prerequisites listed in Section 5 are met. Allocate the necessary 
disk space on the server and create Working Directories for the users following the guidelines 
in Section 5.  

Prior to installing KS Server on a machine that has a previous version of KS Server running, 
notify the users to exit the application, as the installer will shut down all KS user processes. 

For deploying KS Server on Windows, follow the instructions in Section 8.1. For deploying KS 
Server on Linux, follow the instructions in Section 8.2. 

After installing KS Server, proceed to Section 8.3, which describes the process of deploying 
KS Workstation as part of the client/server configuration.  

Note: In the client/server configuration, both KS Workstation and KS Server must be of the 
same major version. For example, KS Workstation 2025.0 works only with KS Server 2025.0 
and does not work with KS Server 2024.1. When upgrading, you must upgrade the clients and 
the server to the new version.  

8.1. Deploying KS Server and Dependent Components on Windows Server 

This section describes the process of installing and configuring KS Server and dependent 
components on Windows Server platforms. 

8.1.1. Install KS Server on Windows 

1. Log in as an administrator to the machine that will host KS Server. 

2. It is assumed you have downloaded the KS Server package following the instructions 
in the email from the License Administrator. Double-click the downloaded MSI 
package KS-Server-2025.0-64bit.msi. 

3. The setup prepares the InstallShield Wizard, and the Welcome window opens. Click 
Next >. 



 

37 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

 

4. The License Agreement window opens. If you accept the terms, select ”I accept”. 

 

Click Next >. 

5. The Setup Type window opens: 

▪ To install KS Server program files to the default location with default settings, 
select the Express option. 



 

38 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

The application program files will be installed in C:\Program Files\Altair 

Data Analytics.  A Windows Service called KSWinLoginService2025.0_64 

will be installed and started automatically. 

 

Click Next > and proceed to Step 7. 

▪ To change the destination for KS Server program files or KS service properties 
such as the TCP port for the service to listen on, select the Custom option. 

 



 

39 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

Click Next >. 

6. If you select the Custom option, the Custom Setup window opens. To change the 
destination folder for the program, click the Change button and specify the desired 
location. The default is C:\Program Files\Altair Data Analytics. 

 

Click Next >. 

7. The Altair License Configuration window opens. 

• If the server has previously been configured for Altair licensing, the values of the 
environment variables ALM_HHWU and/or ALTAIR_LICENSE_PATH are 

displayed. Click Next > to accept the existing configuration. 

Example 1: The machine is already configured for managed Altair Licensing 
(ALM_HHWU=True): 
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Example 2: The machine is already configured for an on-premises Altair License Server 
licensing (ALTAIR_LICENSE_PATH=6200@<server_name>; ALM_HHWU=false): 

 

 

• If the host machine has not previously been configured for Altair licensing, enter 
the license configuration information. Choose the licensing method: Managed 
Altair Licensing or On-premises Altair License Server.  

Contact your team members responsible for Altair product licenses if you are not sure 
which licensing method is going to be used. 
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o If you select Managed Altair Licensing, once you click Next >, the system 
environment variable ALM_HHWU will be created, and its value will be set 

to True. 

o If you select On-premises Altair License Server, specify the license 
server address and port in the format <port>@<host>, for example, 

6200@server1.  
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Once you click Next >, the system environment variables 
ALTAIR_LICENSE_PATH and ALM_HHWU will be created. The former will 

be assigned the value you specified, and the latter will be set to False. 

See Section 14 for detailed information about the licensing methods. 

8. The Windows Service Setup window opens.  

The option Install KSWinLoginService as a Windows Service is selected by 
default. Leave it selected unless you are installing KS Server for Real-Time Scoring 
Web API only. If you deselect it, you will have to start KS Server manually from the 
command line, and it will not be restarted automatically after the server is rebooted. 

Specify the TCP port for the service. The default is 5470. The port must be open for 
inbound connections on the server, as described in Section 8.1.4, “Configuring KS 
Service”. 

 

Click Next >  

9. Click Install to start the installation. 
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10. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 

 

After the installation, open Windows Services and verify that the service 
KSWinLoginService2025.0_64 is running, and its Startup Type is ‘Automatic’. 
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11. If you select the Managed Altair Licensing option at Step 7, authorize the server for 
the Managed license as follows: 

• Run Command Prompt as administrator. 

• Change to the folder C:\Program Files\Altair Data Analytics\KS 
Server 2025.0.0\security 

• Run the following command, where <username> is your Altair One login ID: 

almutil -a1auth -system -username <username> -passwd 

You will be prompted for your password to log in to Altair One. The successful login 
will automatically authorize the machine. 

If you are not registered at Altair One, ask a registered user to generate and send 
you an authorization code at Altair One, then use the following command: 

almutil -a1auth -system -code <auth_code>  

For detailed information on the almutil usage and advanced options including proxy 
configuration, run almutil with no arguments. See also Section 14. 

8.1.2. Install KS Library for R Integration on Windows Server 

Knowledge Studio and Knowledge Seeker support integration with R software 
environment for statistical computing. If the intended users are going to use this feature, 
install KS Library for R on the server as described below. 

Prerequisites: R software and KS Server. R is only required on the server side. In the 
Prerequisites section above, see Subsection 5.2: ”R Software for Statistical Computing”. 

1. Make sure KS Server 2025.0 and R v4.0.0 or higher are installed. 

2. Download KS Library 2025.0 for R 4.0 or higher from the Altair software download 
site. 

3. Uninstall any previous version of KS Library for R from the Programs and Features list 
in the Windows Control Panel. 

https://altairone.com/
https://www.r-project.org/
https://www.r-project.org/
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4. Double-click the downloaded package for KS Library for R. Click Next > in the 
Welcome screen.  

 

5. In the License Agreement window, select “I accept” if you accept the terms and click 
Next >. 
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6. The Destination Folder window opens. KS library for R will be installed into <R root 

folder>\R-X.X\library\, where R-X.X is the most recent version of R on the 

host machine. The standard R root folder is C:\Program Files\R. The default 

folder to extract the temporary setup files is C:\Program Files\Altair Data 

Analytics. To change any of these folders, click the Change button. 

 

Click Next >. 

7. Click Install. 
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8. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 

 

As a result, three subfolders containing the required R integration libraries are created 
under <R root folder>\R-X.X\library\ : 

• angoss 

• KnowledgeSurvival 

• xtable 

If users are required to use a different R library path, copy the folders angoss, 

xtable, and KnowledgeSurvival to the desired R library location. 

Note: The Rserve package, whose installation was described in Section 5.2.3, must be 
present in the same R library location. 

8.1.3. Installing Altair SLC 

1. Download the latest versions of Altair SLC from AltairOne Marketplace. If you don’t 
have an AltairOne account, please reach out to the person managing Altair software 
licenses at your organization or contact Altair Data Analytics Customer Support at 
dasupport@support.com. 

2. Run the downloaded Altair SLC installation package. Click Next > in the Welcome 
screen.  

https://cran.r-project.org/web/packages/Rserve/index.html
https://altairone.com/Marketplace?queryText=SLC&tab=Info&app=Altair+SLC
https://altairone.com/Marketplace
mailto:dasupport@support.com


 

48 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

 

3. In the End-User License Agreement window, select “I accept the terms in the 
License Agreement” if you accept the terms. Click Next >. 

 

4. In the Custom Setup page, select all Altair SLC program features, as shown below. To 
change the destination folder for the application program files, click the Change button 
and specify the desired location. The default is C:\Program Files\Altair\SLC\<version>. 
Click Next >. 
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5. Click Install to start the installation. 

 

6. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 
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7. Altair SLC only contains the compiler engine without graphical user interface 
components. The graphical user interface is provided by the Altair Analytics 
Workbench on the client side. 

Altair SLC uses the same license as Knowledge Studio Server. Activating KS Server 
with an Altair Units License automatically activates Altair SLC on the same machine. 

8.1.4. Configure KS Service (KSWinLogin Service) 

The Windows service KSWinLoginService2025.0_64 is installed and started 
automatically if you chose the default Windows Service Setup option in the KS Server 
installation wizard. 

The service is listening on the port that was specified in the wizard. The default is 5470. 
If you want to change the default port for KSWinLogin Service, specify the desired port 
number in the KS Server configuration file KSWinLogin.conf, whose default location is 
C:\Program Files\Altair Data Analytics\KS Server 2025.0.0\bin. 

For example, to change the default port to 5480, open the file KSWinLogin.conf in a text 
editor and add the following line: 

port 5480 

Then open Services from the Windows Control Panel | Administrative Tools and restart 
KSWinLoginService2025.0_64.  

Upon each client connection from KS Workstation, KS Server creates a process called 
KSWinLogin.exe. Server administrators can monitor these processes in the Task 
Manager. Connection attempts are logged in the Windows Server Event Viewer in the 
Application and Security logs in the Windows Logs folder.  

 



 

51 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

Cryptographic Protocols:  

TLS1.2 is used by default. The older versions TLS1.1, TLS1.0, and SSL are never 
used. 

Windows Firewall configuration 

Create a new inbound rule for the KS Server TCP port.  

In your Windows Server Control Panel, open System and Security → Administrative 
Tools → Windows Firewall with Advanced Security 

 

Expand the top item in the left panel and open Inbound Rules. In the Actions panel on 
the right, click New Rule… 

In the New Inbound Rule Wizard, select the Port option. 
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At the next step, select the TCP option and choose “Specific local ports”. Then specify 
the port(s) to open for inbound connection from the client machines. Note: If you 

configured KS Server to run on a non-default port, replace “5470” below with the port number you 
specified in KSWinLogin.conf. 

• For Knowledge Seeker or Knowledge Studio: 

o enter port number 5470 

o if users require the Jupyter Notebook integration feature, in addition to 
5470, specify the range of TCP ports to be used by Jupyter Notebook 
users (for example, 8800-8900) 

• For Knowledge Studio for Apache Spark, open port 5470 and the port range 
6060–6090. 

See the example screenshot below. 
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At the next step, select the option “Allow the connection” or “Allow the connection if it is 
secure”, depending on your security requirements. 

 

At the next step, select the desired profiles depending on your security requirements. At 
least the Domain profile is usually required. 
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At the next step, enter the name for the new rule (for example, “Altair KS Server”) and 
optional description.  

 

Click Finish. The new rule will be created in the Windows Firewall with Advanced 
Security configuration. 
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8.1.5. Configure User Rights on the Server 

Create a user group that includes all intended users of KS Server in the client/server 
mode. For example, call it KS_Users. Note: Creating the group is optional. You may 
choose to add permissions to an existing user group that includes all potential KS 
Server users, or to individual users instead. 

▪ Open the Local Security Policy or Local Security Settings item of the Server 
Administrative Tools. Open Local Policies and select User Rights Assignment. 

▪ Edit the following policies to add the KS user group or individual users: 

➢ Access this computer from the network  

➢ Either Allow Log on locally OR Log on as a batch job, depending on the 
security requirements in your network. 
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▪ If you choose the option Log on as a batch job, update the KS Server 
configuration file KSWinLogin.conf. Its default location is C:\Program 

Files\Altair Data Analytics\KS Server 2025.0.0\bin. Open 

the file KSWinLogin.conf in a text editor and add the line 

logon_type batch 

▪ Restart the service KSWinLoginService2025.0_64 

8.1.6. Configure Altair SLC and SSH Server 

Configure Altair SLC 

1. Create a new parent folder on the server for the Altair SLC standard libraries 
SASUSER and WORK. The WORK library is for temporary files. It is 
recommended to use the same drive where the Knowledge Studio users’ working 
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directories are set up. For example, create a new folder D:\ALTAIRSLC_HOME. 
This folder must have Read & Write permissions for all KS Server users.  

2. Edit the configuration file altairslc.cfg located in the Altair SLC root folder 
C:\Program Files\Altair\SLC\<version_number>. Change the values of the 
SASUSER and WORK parameters in altairslc.cfg. For example, if the folder you 
created is D:\ALTAIRSLC_HOME, then specify:  

-SASUSER 'D:\ALTAIRSLC_HOME\!USERNAME\My SLC Files' 

-WORK 'D:\ALTAIRSLC_HOME\!USERNAME\TEMP' 

Save the changes in altairslc.cfg. 

Note: In case of any issues with user-specific subfolders, you may omit the 
!USERNAME variable referring to user-specific locations and define common 

SASUSER and WORK locations as follows (not recommended, as this is a less 
organized way): 

-SASUSER 'D:\ALTAIRSLC_HOME' 

-WORK 'D:\ALTAIRSLC_HOME\TEMP' 

3. Set the environment variables for the Altair SLC integration: From the Windows 
Server Control Panel, open System → Advanced System Settings, go to the 
Advanced tab and click Environment Variables.  

a) In the System Variables section, click New and add an environment variable 
ANGOSS_DLL with the value AngossData64-2025.0.dll 

b)  In the System Variables section, select the PATH variable, click Edit, and 
add the path to the KS Server bin folder at the end. For example, if KS 
Server is installed in the default location, this is C:\Program 
Files\Altair Data Analytics\KS Workstation 2025.0.0\bin  

Install and Configure Bitvise SSH Server 

Bitvise SSH server is required for Altair SLC integration for Knowledge Studio in the 
client/server mode. It can be downloaded from https://www.bitvise.com/ssh-server-
download. Install and configure the standard, fully functional Bitvise SSH server edition. 
The detailed configuration instructions are available here: 
https://www.bitvise.com/configuring-ssh-server-for-sftp. Below is a brief description of the 
installation and configuration steps suitable for most cases: 

1. Download the file BvSshServer-Inst.exe and run the downloaded executable. In 
the installation wizard, make sure you select the standard, fully functional Bitvise 
SSH server edition that supports domain accounts. 

2. When the installation is complete, the Bitvise SSH Server Easy Settings window 
appears. In the Server Settings tab, select the desired option for “Open 
Windows Firewall”. If you choose any option other than “Open port(s) to any 
computer”, make sure the listening port is accessible to the computers of all KS 
Server users. 

https://www.bitvise.com/ssh-server
https://www.bitvise.com/ssh-server-download
https://www.bitvise.com/ssh-server-download
https://www.bitvise.com/configuring-ssh-server-for-sftp
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Check the settings in the Windows accounts tab and modify them if necessary 
(see the next screenshot). Make sure that logging in to Windows domain 
accounts of KS Server users is allowed. 

 

If required, configure access for the Virtual accounts in the third tab. 

3. If you choose not to start the server upon closing the Easy Settings dialog, start it 
from the Bitvise SSH Server Control Panel, as shown below. Easy Settings and 
Advanced Settings are also available in the same Control Panel dialog. For 
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detailed description of advanced settings, see 
https://www.bitvise.com/configuring-ssh-server-for-sftp   

 

4. Windows Firewall configuration for Bitvise SSH Server: Depending on your 
Windows Firewall configuration and security rules, you may need to edit the 
default Inbound rules for Bitvise SSH Server. In your Windows Server Control 
Panel, open System and Security → Administrative Tools → Windows Firewall 
with Advanced Security 

https://www.bitvise.com/configuring-ssh-server-for-sftp
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5. Expand the top item in the left panel and open Inbound Rules. Double-click the 
rule “Bitvise SSH Server (TCP/IPv6 22)” to open its properties. Go to the Scope 
tab of the Properties dialog and specify the desired Remote IP address range for 
computers allowed to access the SSH server. Make sure the users’ computers 
are within this range. 
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6. Go to the Advanced tab of the Properties dialog and specify the desired profiles 
to which the rule applies. Make sure the computers of the KS Server users fit at 
least one of these profiles. 

 

7. Set the same properties for the rule “Bitvise SSH Server (TCP/IPv4 22)”. 

8.2. KS Server Installation and Configuration on Linux 

This section describes the process of installing and configuring KS Server and dependent 
components on Linux. For system requirements and prerequisites, see Section 3 and 
Section 5. Follow the steps below. 

8.2.1. Configure Pluggable Authentication Modules (PAM) for KS Service 

Define the authentication rules for KS Server by creating the KS Service configuration 
file kslogin in /etc/pam.d/. Since these rules should normally be the same as those 

for the standard login service, create kslogin by copying the login configuration file: 

cp /etc/pam.d/login /etc/pam.d/kslogin 

For more information about PAM modules and options, see the system-level 
administration guide in your Linux OS documentation and http://www.linux-pam.org/. 

http://www.linux-pam.org/
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8.2.2. Install KS Server on Linux 

1. Download the KS Server installation package for your Linux system from the 
Altair software download site. For example, for Red Hat enterprise Linux 8, the 
file name is KS-Server-2025.0-rhel8_x64.rpm. Copy the downloaded file to a 
directory on the server. 

2. Log in to the server as root.  

3. If you are upgrading from a previous version of KS Server, note that the installer 
will shut down all current KS Server processes. Notify the users if necessary. To 
check if any KS user processes are running, use the command 

ps -ef | grep kslogin 

4. Run the installer. For example, on Red Hat Enterprise Linux 8, run the command 

rpm -ivh KS-Server-2025.0-rhel8_x64.rpm 

This installs KS Server to /opt/Altair-Data-Analytics and starts the KS 

service kslogin.  

To install to a different directory, specify the desired path after the --prefix 

switch. For example, this command installs KS Server to /apps/Altair-

Data-Analytics on Red Hat Enterprise Linux 8: 

rpm -ivh --prefix=/apps KS-Server-2025.0-rhel8_x64.rpm 

5. Verify that the KS service has started successfully. The following messages 
indicate the successful start: 

/opt/Altair-Data-Analytics/KS-Server-

2025.0/lib/kslogin(service_pid=2951,server_pid=2952) 2024-

08-09 23:33:06 server start: port 5470 

/opt/Altair-Data-Analytics/KS-Server-2025.0/lib/kslogin: 

logging to kslogin.log 

8.2.3. KS Libraries for R and Python 

This section describes the steps to install and configure R and Python integration 
libraries. 

Install and configure KS Library for R 

If the R integration features are required, make sure that R version 4.0.0 or 
higher is installed as described in Section 5.2. 

In the examples below, it is assumed that R is installed under /usr/lib64/R. 

1. Edit the KS Server startup script ks_start, whose default location is 
/opt/Altair-Data-Analytics/KS-Server-2025.0. In the R environment 

section, specify the value for the R_HOME environment variable if the R home 

directory on your server is different from the default specified here: 
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R_HOME=/usr/lib64/R 

export R_HOME 

2. Uninstall any previous version of KS Library for R as follows:  

R CMD REMOVE angoss 

R CMD REMOVE KnowledgeSurvival 

3. Install KS Library for R: 

cd /opt/Altair-Data-Analytics/KS-Server-2025.0/R 

Rscript angossSetupR.R 

This will create three directories under the R library location 
/usr/lib64/R/library/: 

• angoss 

• KnowledgeSurvival 

• xtable 

If any users need to use a different R library path, copy the directories angoss, 

KnowledgeSurvival, and xtable to the desired R library location. Note that 

the Rserve library must exist in the same R library location (see Section 5.2.3). 

Configure KS Library for Python 

If Python integration features are required, make sure that Python or one of its 
distribution packages has been installed as described in Section 5.3. 

Edit the KS Server startup script ks_start in /opt/Altair-Data-Analytics/KS-

Server-2025.0. In the Python environment section, specify the value for the 

PYTHON_HOME environment variable. It must point to the parent directory of the 

Python bin and lib directories. For example, if your Python is a part of Miniforge 

installed in /opt/miniforge3, then set PYTHON_HOME to /opt/miniforge3: 

PYTHON_HOME=/opt/miniforge3 

export PYTHON_HOME 

8.2.4. Install and Configure Altair SLC 

1. Download the installation package for Altair SLC for Linux (x64) from the Altair 
Marketplace and copy it to the server where KS Server is installed. If you don’t have 
an AltairOne account, please reach out to the person managing Altair software 
licenses at your organization. 

2. Install Altair SLC for Linux by running the command 

rpm --install <slc-installation-file>.rpm 

The default installation location is /opt/altair/slc/2024  

https://cran.r-project.org/web/packages/Rserve/index.html
https://altairone.com/Marketplace?tab=Info&app=Altair+SLC
https://altairone.com/Marketplace?tab=Info&app=Altair+SLC
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3. Create a symbolic link /opt/altairslc pointing to the Altair SLC root directory. For 

example, if Altair SLC is installed in /opt/altair/slc/2024, then link it as follows: 

ln -s /opt/altair/slc/2024 /opt/altairslc 

If creating a symbolic link in /opt is not desirable, define the environment variable 
WPS_HOME in ks_start: export WPS_HOME=/opt/altair/slc/2024 

4. Edit the configuration file altairslc.cfg in /opt/altair/slc/2024 and modify 

the SASUSER and WORK attributes as follows:  

-SASUSER '!HOME/altairslc' 

-WORK '!HOME/altairslc/tmp' 

(note: you can choose any name instead of ‘altairslc’).  

5. Make sure that the OpenSSH server process (sshd) is running. Refer to the Linux 

documentation for the information on the openssh-server and openssh packages and 
starting the sshd daemon. For example, for RHEL 7, see OpenSSH for RHEL 7. 

6. Create the altairslcenv.sh shell script for SLC environment in the ALTAIR SLC 

root directory /opt/altair/slc/2024 and define the following environment 

variables in this script (in this example, KS Server is assumed to be installed in /opt): 

export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/opt/Altair-Data-

Analytics/KS-Server-2025.0/lib 

export ANGOSS_DLL="libAngossData.so" 

For a self-hosted Altair License Server, define the ALTAIR_LICENSE_PATH variable 
(for altair_license_server, substitute the name or IP address of the Altair 

License Server host machine): 

export ALTAIR_LICENSE_PATH=6200@altair_license_server 

For a Managed license hosted in the Altair cloud, the define ALM_HHWU variable: 

export ALM_HHWU=true 

8.2.5. Configure KS Service and Security 

This section describes the steps to configure KS service, the firewall for KS Server 
security, set KS service runtime parameters, and configure database connections. KS 
Server must be restarted as described in the next section for any configuration change to 
take effect. 

Configure KS Service 

The KS Server configuration file kslogin.conf defines the runtime parameters of the 
service such as the port number for the KS service to listen on, the log file name and 
location, etc. The default location of the service configuration file is 

/opt/Altair-Data-Analytics/KS-Server-2025.0/lib 

Example configuration file kslogin.conf: 

https://access.redhat.com/documentation/en-us/red_hat_enterprise_linux/7/html/system_administrators_guide/ch-openssh
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port 5470 

backlog 10 

log kslogin.log 

ssl_cert   ssl_cert.pem 

ssl_key    ssl_key.pem 

• The default port number for KS service is 5470. The port number is defined 
by the port parameter. Specify a different port if necessary. 

• The backlog parameter is related to the socket configuration. It defines the 
maximum length that the queue of pending connections may grow to. The 
default value (10) is suitable in most cases.  

• The log parameter defines the name of the KS service authentication log 
file. When its name is specified without the full path, it is located in 
<install_dir>/Altair-Data-Analytics/KS-Server-2025.0. To 

keep the log in a different location, specify the full path, for example: 
/opt/Altair-Data-Analytics/logs/kslogin.auth.log 

• The ssl_options parameter determines the cryptographic protocol to be 
used by KS Server. TLS1.2 is used by default.  

Deprecated protocol versions TLS1.1, TLS1.0, and SSL are never used. 

• The ssl_cert and ssl_key parameters name the files containing the SSL 
certificate and key, respectively. Their default values are ssl_cert.pem and 
ssl_key.pem, and the designated location for these files is the KS Server lib 
directory, which also contains kslogin.conf. These files must exist, and the 
OpenSSL library must approve of them, otherwise any connection attempt 
will fail. If necessary, generate your own certificate/key pair and copy it to 
the KS Server lib directory. An example command to generate the SSL 
certificate and key: 

openssl req -x509 -nodes -days 10000 -subj '/' -newkey 

rsa:4096 -keyout ssl_key.pem -out ssl_cert.pem 

• The authenticator parameter defines the authentication mechanism. The 
default authenticator is PAM. If you are using other authentication methods 
where users do not necessarily have entries in /etc/passwd, specify an 

alternative authentication mechanism, for example: 

authenticator pw 

For setting optional advanced runtime parameters, see Chapter 12. 
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Configure Firewall for TCP Port Connections 

Create inbound rules in the Linux firewall for the TCP ports used by KS Server. 
Inbound connections to the KS Server host must be allowed on these ports from the 
KS Workstation client machines. 

• For Knowledge Studio or Knowledge Seeker, open the port specified in 
kslogin.conf (the default is 5470) 

• For Knowledge Studio for Apache Spark, open the port specified in 
kslogin.conf (the default is 5470) and the port range 6060–6090. Ensure the 
network connectivity between the KS Server host and the Apache Spark 
Server. 

8.2.6. Environment for Database Connectivity 

This step is necessary only if the users need to import data from databases. See 
Section 5.5 for prerequisites. 

1. Install the ODBC drivers for the required databases. Native ODBC drivers are 
recommended. For example, for Apache Hadoop, use the Hortonworks or 
Cloudera ODBC drivers available for free from the respective vendors. 

2. Edit the file ks_odbc in the KS Server home directory to set the ODBC 
environment if necessary. The example below assumes that your unixODBC 
libraries are in /usr/lib64 and odbc.ini is in /etc. If you do not define 

ODBCINI and ODBCSYSINI in ks_odbc, the unixODBC defaults will be used. 

export ODBCINI=/etc/odbc.ini 

export ODBCSYSINI=/etc 

export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/lib64 

3. You may need to add other environment variables depending on the 
requirements for the ODBC driver and the source databases. Please refer to the 
ODBC driver documentation. For example, for the Cloudera native ODBC driver 
for Apache Hive, define the CLOUDERAHIVEINI variable. 

4. Edit the odbc.ini file of unixODBC to configure the Data Source Names (DSN) 
for the desired databases. You may need the help of the database administrator 
to get the host name for the database server, the database name, port number, 
or other connection parameters. An example odbc.ini is provided below. For the 
detailed guide to configuring odbc.ini for data access, refer to 
http://www.unixodbc.org/ and your ODBC driver documentation. 

DSN Configuration Example: 

The following odbc.ini example file defines Data Source Names (DSN) for 
Teradata, Oracle, MySQL, SQL Server, and Apache Hive databases.  

[ODBC Data Sources] 

TeradataDB=Teradata ODBC Driver 

OracleDB=Oracle Native ODBC driver 

SQL_Server=Microsoft ODBC Driver 13 for SQL Server 

http://www.unixodbc.org/


 

67 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

MySQL=MyODBC 5.3.10 Driver DSN 

HortonWorksHive64=Hortonworks Hive ODBC Driver 64-bit 

 

[ODBC] 

# Specify any global ODBC config here such as ODBC tracing. 

 

[TeradataDB] 

Driver = /opt/teradata/client/ODBC_64/lib/tdataodbc_sb64.so 

DBCName = tddb.us.cloudapp.azure.com 

 

[OracleDB] 

Driver = /usr/lib/oracle/12.2/client64/lib/libsqora.so.12.1 

ServerName = db_server_name 

Database   = SAMPLE 

SID        = orcldb.company.com 

 

[SQL_Server_1] 

Description=Microsoft ODBC Driver 13 for SQL Server 

Driver=/opt/microsoft/msodbcsql/lib64/libmsodbcsql-

13.1.so.9.2 

Database=sample_db 

Server=db_server_name,1433 

UID= 

PWD= 

 

[MySQL] 

Driver       = /usr/lib64/libmyodbc5a.so 

Description  = Connector/ODBC 5.3.10 Driver DSN 

SERVER       = mysqldb_server_name 

PORT         = 3306 

USER         = dbuser1 

Password     = 

Database     = db_name 

OPTION       = 3 

SOCKET       = 

 

[HortonworksHive64] 

Description=Hortonworks Hive ODBC Driver (64-bit) DSN 

Driver=/usr/lib/hive/lib/native/Linux-amd64-

64/libhortonworkshiveodbc64.so 

HOST=hdp_server_name 

PORT=10000 

Schema=default 

ServiceDiscoveryMode=0 

ZKNamespace= 

HiveServerType=2 

AuthMech=2 

ThriftTransport=1 

UseNativeQuery=0 

UID= 

KrbHostFQDN=_HOST 
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KrbServiceName=hive 

KrbRealm= 

SSL=0 

TwoWaySSL=0 

ClientCert= 

ClientPrivateKey= 

ClientPrivateKeyPassword= 

8.2.7. Starting and Stopping KS Service 

The KS service kslogin starts automatically upon the KS Server installation and listens 
to KS client connections. This section describes the use of KS Server scripts for starting 
and stopping the KS service. 

Starting KS service using ks_start: 

1. Log in as root. 

2. Change to the KS Server home directory. For example: 

cd /opt/Altair-Data-Analytics/KS-Server-2025.0 

3. Run ks_start: 

./ks_start 

The following messages confirm that the KS service started successfully: 

/opt/Altair-Data-Analytics/KS-Server-

2025.0/lib/kslogin(service_pid=2951,server_pid=2952) 2024-

01-02 23:33:06 server start: port 5470 

/opt/Altair-Data-Analytics/KS-Server-2025.0/lib/kslogin: 

logging to kslogin.log  

The service is now ready to accept connections from KS Workstation clients. 
You will be able to test the client/server connection and install the license after 
deploying KS Workstation on Windows (see Section 8.3).  

If any errors are reported, see Section 8.2.8, “Troubleshooting”. 

Stopping the service using ks_shutdown: 

To stop the KS service and all KS users’ kslogin processes on the server, use the 
ks_shutdown command in the KS Server home directory: 

cd /opt/Altair-Data-Analytics/KS-Server-2025.0 

./ks_shutdown 

To restart the KS service, use ks_shutdown first and then run ks_start. 

To stop only a particular user’s process rather than the entire KS service, list all 
kslogin processes first, then kill the process running under this specific user ID: 

ps -ef | grep kslogin 
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get the process ID of the user 

kill -9 <process ID> 

8.2.8. Automating KS Server Startup with Linux Service Management Tools 

This section describes how to make the KS Server service start automatically at boot 
time and use service management commands to start and stop KS Server.   

KS service can be managed using systemd and systemctl. The examples below 
assume that KS Server is installed in the default location under /opt. 

1. Make sure that KS service can be started successfully using ks_start as 

described in the preceding section. 

2. Copy the file ks.service from the KS Server home directory to 

/etc/systemd/system 

cd /opt/Altair-Data-Analytics/KS-Server-2025.0 

cp ks.service /etc/systemd/system 

3. Create a symbolic link "KS-Server" to the KS-Server-2025.0.0 directory in the 

Altair-Data-Analytics directory: 

cd /opt/Altair-Data-Analytics 

ln -s KS-Server-2025.0.0 KS-Server 

4. Enable the ks service by running the command:  

systemctl enable ks 

This will make KS Server start at boot time. 

• To start KS Service, run the command 

systemctl start ks 

• To stop KS Service at any time, run the command  

systemctl stop ks 

• To check if KS Server is running, run the command  

ps -ef | grep kslogin 

For more information on systemd and systemctl, see your Linux System 

Administrator documentation. For example, Managing systemd for RHEL 8. 

https://docs.redhat.com/en/documentation/red_hat_enterprise_linux/8/html/configuring_basic_system_settings/managing-systemd_configuring-basic-system-settings
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8.2.9. Troubleshooting 

Errors at service startup 

If starting the KS Server service results in error messages, this may indicate that the 
environment is not set properly, or the system is not at sufficient maintenance level, and 
certain patches need to be installed. 

Connectivity issues 

▪ Connection loss: If an end user working in client/server mode with server on 
Linux gets an exception resulting in the loss of connection with the server, in most 
cases, the problem is resolved on the client side by simply reconnecting to the 
server using the command File | Connect from the application menu. The KS 
Server service on the Linux server does not need to be restarted. 

If you have to restart KS Service, notify the users that it is about to be shut down. 
Then shut down and start KS Service using any of the ways described in Sections 
8.2.5 and 8.2.6. 

▪ Authentication issues: If users get the error message "Authentication failure" or 
similar errors when trying to connect, the most likely cause is incorrect settings in 
the configuration file kslogin.conf. Verify that the parameters in kslogin.conf are 
set properly according to Section 8.2.5, depending on your operating system. 

▪ Failure to connect: If a user gets the error, "No connection could be made 
because the target machine actively refused it", there are two possible causes:  

a) KS service is not running. 

b) The user specified the wrong port number or host name when connecting to 
KS Server. 

To fix this problem, make sure the kslogin service is running on the server using 
the command ps -ef | grep kslogin. The process "kslogin kslogin.conf" 

owned by root must be running. 

Make sure the user specifies the correct port number and host name in the 
connection dialog. The port number must be the one indicated in the kslogin.conf 
configuration file. 

▪ Abnormal termination of the client/server connection: If the network 
connection between the client machine and the server is lost, the corresponding 
KS server process on the server (KSWinLogin.exe) is automatically terminated 
several minutes after the connection loss. 

Testing the ODBC Connection  

After installing KS Workstation (Section 8.3) and activating the license, test the 
database connectivity as follows. 

1. Run KS Workstation 2025.0 on a Windows client machine and connect to KS 
Server. If necessary, use the Connect command from the File menu and 
specify the KS connection information. 
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2. When connected, install the license if it is not already installed. See Chapter 14 
of this document for the license installation instructions. 

3. Create a new project by selecting Create Project from the File menu.  

4. Right-click anywhere on the Workflow Canvas and select Connect → ODBC 
Import from the context menu. The ODBC Import Wizard will open. 

5. In the ODBC Connection page (see the screenshot below), select the DSN 
option, select the DSN you configured, specify the database user ID and 
password and click Next >. 

NOTE: If you are connecting to DB2, the very first connection must be 
performed with the user ID that has sufficient privileges to create packages. 
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If your DSN is not in the list, this means it is not in the [ODBC Data Sources] 

section of odbc.ini, or the ODBC environment was not configured correctly. 

6. Click Next. The list of your database tables will be displayed in the next page of 
the wizard. Select a table and import data from it. 

If you fail to connect to the database or import any table, check your DSN 
parameters in odbc.ini or consult with your database administrator. 

Troubleshooting Database Connectivity Issues:  

o If no tables are displayed after connecting to a database, check the 
UseCurrentSchema parameter (if available) in the DSN description for 
your database in odbc.ini. If UseCurrentSchema=1, the database driver 
looks for tables only in the default schema (the schema with the same 
name as the database user name specified in the wizard). Change it to 
UseCurrentSchema=0 so that the driver could look for tables in all 
accessible schemas and try connecting again. 

License Errors 

o For KS Server on Linux, if you get an error message that 
textrel_shlib_t failed to run, this is caused by lack of an exec 

permission on the /tmp partition. Change the location of the temporary 
files for Altair licensing by defining the TMPDIR variable inside the 
ks_start script. For example, create a new directory alm_tmp under the 

KS Server home directory and add the following line to ks_start: 

export TMPDIR=$KSTUDIOHOME/alm_tmp 

System Configuration for Large File Support 

 
Some operations in KS Server, such as importing a large file, may take a lot of memory. It 
may be necessary to adjust the resource limits of your operating system. 

Edit the file /etc/security/limits.conf to view or set the desired ulimit values to 

increase file size limits and process memory size limit if necessary. See the manual 
pages for ulimit and your Linux System Administrator documentation for details. 

8.3. Deploying Client Components for Client/Server Configuration 

This section describes the interactive installation of KS Workstation (desktop client) and 
dependent components on the client machines as part of the deployment procedure for the 
client/server configuration. It is assumed that KS Server is already installed on the server. 
For non-interactive installation modes such as silent install, see Section 9. 

8.3.1. Installing KS Workstation 

1. Log in to the client machine as a user with sufficient rights to install software. 

2. Double-click the downloaded MSI package KS-Workstation-2025.0-64bit.msi. 
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3. The setup prepares the InstallShield Wizard, and the Welcome window opens. 
Click Next >. 

 

4. The License Agreement window opens. If you accept the terms, select “I accept” 
and click Next > 

 

5. The Configuration Type window opens. Select the Client/Server configuration 
option and click Next >. 
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6. If necessary, change the destination folder for the application program files on 
the client machine by clicking the Change button and specifying the desired 
location. The default is C:\Program Files\Altair Data Analytics. Click Next >. 

 

7. The KS Server Connection Properties window opens. 

▪ In the Host field, enter the name or the IP address of the server where KS 
Server is installed. 
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▪ In the Port field, enter the port number to be used by the client to connect to 
KS Server. The default port number is 5470. If you change it, make sure it is 
the same as the one specified in the KS Server configuration (see Section 
8.1.4. “Configuring the KS Service”). 

▪ In the Working Directory field, enter the working directory for the users’ 
project files. 

Note 1: This directory path must be a local path with respect to the server 
(for example, D:\Altair KS Projects\ for Windows Server, or 
/apps/ks_projects/ for Linux). You can use a network path such as 
\\server1\ks_projects if the Working directory is on a network drive. The 
Working Directory must have Read & Write permissions for the intended 
users.  

Note 2: The end users can change their Working Directories at any time after 
the installation using the Set Working Directory command in the File menu. 
For example, if you created subdirectories user1, user2, … userN under 
D:\Altair KSProjects, instruct the users to set their Working Directories to the 
respective folders D:\Altair KS Projects\userN.  

 

Click Next >. 

8. At the final step, choose whether to install a desktop shortcut for KS Workstation. 
Click Install to start the installation. 
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9. The Setup Status window opens. It shows the installation progress. When the 
installation is complete, click Finish.   

 

10. The installed software is now available as KS Workstation in the program group 
Start | Programs | Altair Data Analytics. 

To activate the product, follow the instructions in Chapter 14: “License 
Administration”. 
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8.3.2. Installing Altair Analytics Workbench 

1. On the client side, the graphical user interface for Altair SLC on the server is provided 
by Altair Analytics Workbench. Run the downloaded Altair Analytics Workbench 
installation package. Click Next > in the Welcome screen.  

 

2. In the End-User License Agreement window, select “I accept the terms in the 
License Agreement” if you accept the terms. Click Next >. 
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3. In the Custom Setup page, select all program features, as shown below. To change 
the destination folder for the application program files, click the Change button and 
specify the desired location. The default is C:\Program Files\Altair\Analytics 
Workbench\<version>. Click Next >. 

 

4. Click Install to start the installation. 
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5. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 

 

6. Altair Analytics Workbench is now available in the Windows Start menu. It can be 
launched by double-clicking the desktop shortcut “Altair Analytics Workbench” or 
selecting Start | Altair | Altair Analytics Workbench. 

9. Alternative Installation Modes on Windows 

9.1. Silent Install 

To install KS Workstation in the silent mode from the command line without user 
interaction, follow these steps: 

1. Copy the downloaded installation package KS-Workstation-2025.0-64bit.msi to a folder 
on the intended host machine. 

2. Run Command Prompt as administrator. For example, on Windows 10, select Start | 
Windows System, right-click on Command Prompt, and select More → Run as 
administrator. 

3. Type msiexec.exe in the command prompt and press Enter. The Windows Installer 
window displays its version and usage options. The syntax of the commands depends 
on the version of Windows Installer on your system. For more information, see the 
Windows Installer Portal and the information on the Command Line Options.  

4. The following examples show how to install KS Workstation in several typical cases.   

• NEW INSTALLATION: To install KS Workstation 2025.0 with default settings to the 
default destination folder C:\Program Files\Altair Data Analytics 

https://docs.microsoft.com/en-us/windows/win32/msi/windows-installer-portal
https://docs.microsoft.com/en-us/windows/win32/msi/command-line-options
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and save the installation log in the file ks_install.log, execute the following 
command as a single line: 

msiexec.exe /package "C:\temp\KS-Workstation-2025.0-

64bit.msi" /quiet /log ks_install.log 

• UPGRADE: To install KS Workstation 2025.0 and apply the preferences of the 
previous version, specify the preferences file of the previous version as an 
argument in the silent install command line. For example: 

msiexec /i "KS-Workstation-2025.0-64bit.msi" /l*v 

"install.log" CWDGROUP="C:\Work\Altair KS Projects" 

PREFERENCES="C:\Users\jsmith\AppData\Roaming\Altair\KSMainNe

t64-2022.0.xml" /quiet 

As a result, all applicable parameters in the specified XML file that correspond to 
the preference values will be set as the default preference settings in Tools | 
Preferences of the installed application. Note that the Working Directory is 
specified separately using the options CWDGROUP or SCWD (see the table 
below). 

• UNINSTALL: To uninstall KS Workstation 2025.0, use the following command as a 
single line: 

msiexec.exe /uninstall "C:\temp\KS-Workstation-2025.0-

64bit.msi" /quiet /log ks_install.log 

The options that can be specified to customize the installation are given below. The values 
must be specified in double quotes, except ALMSERVER. Examples are given below. 

ALMSERVER 
Self-hosted Altair License Server host name or IP address.  

Example: ALMSERVER=6200@server1 

MANAGEDLICENSE 

True or False. Determines whether Managed Altair Licensing is 
used. The installer creates the system environment variable 
ALM_HHWU with the specified value. 

Example: MANAGEDLICENSE=True 

PREFERENCES 

The preferences file that contains the application preferences to 
be applied. Example syntax:   

PREFERENCES="C:\TEMP\KSMainNet64-2024.2.xml" 

CWDGROUP 

Working Directory location in the Standalone mode. The default is 
the “Altair” folder under the current user’s My Documents folder. 
Not applicable to the client/server mode. When deploying the 
client for the client/server configuration (KSSERVERTYPE=2) use 

the SCWD keyword to set the Working Directory on the server. 



 

81 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

SCWD 
The Working Directory location on the server (in the case of the 
client/server configuration). This is used in combination with 
KSSERVERTYPE=2 (see below).  

INSTALLDIR 
Installation directory. The default is “C:\Program 

Files\Altair Data Analytics” 

DSKTOPSTCUT Desktop shortcut option (“1” if required to create; “0” otherwise) 

PDFPRINTER 
Install Amyuni PDF Printer. (“1” if required to install; “0” 
otherwise). The printer driver is required for users to be able to 
save trees, tables, charts, and reports as PDF. The default is “1”. 

KSSERVERTYPE 

Determines whether the mode is Standalone or Client/Server. 

“1” -  the standalone mode. This is the default option. 

“2” -  the client/server mode (KS Workstation serves as a client to 
connect to KS Server) 

KSHOSTNAME 
The name of the KS Server host to connect to. (Applicable to the 
client/server configuration, when KSSERVERTYPE=”2”) 

KSPORT 

The TCP port number for the KS Workstation (client) to connect 
to KS Server. The default is “5470”. 

Applicable only to the client/server configuration, when 
KSSERVERTYPE=”2” and KSHOSTNAME is specified. 

 

Here is an example command (must be specified as a single line in the command prompt 
or script): 

msiexec.exe /package "C:\Temp\KS-Workstation-2025.0-64bit.msi" 

/quiet /log ks_install.log INSTALLDIR="D:\Program Files\Altair 

Data Analytics" ALMSERVER="6200@server1" MANAGEDLICENSE=False  

CWDGROUP="C:\Users\jsmith\Documents\Altair" DSKTOPSTCUT="1" 

PDFPRINTER="1" 

If you are performing silent install on multiple PCs at the same time, after the installation 
you can set the default configuration (client/server or standalone mode, server name to 
connect, port number, and default Working Directory) on the client side by replacing the INI 
file in the KS Workstation program folder on every client PC. The configuration file is 
C:\Program Files\Altair Data Analytics\KS Workstation 

2025.0.0\bin\KDSConnection.ini  

For example, if you want KS Workstation to connect by default to a specific server and set 
the working directory to D:\KS_Projects, the contents of KDSConnection.ini should be: 

<Config> 

<Mode>1</Mode> 
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<Location>D:\KS_Projects</Location> 

<Service></Service> 

<User></User> 

<Host>KS_server_name_or_ip_address</Host> 

<Port>5470</Port> 

<Secure>True</Secure> 

</Config> 

9.2. Customizations to Assist in Repackaging for Deployment 

The KS Workstation installer and software support the capability of deploying on a large 
number of workstations using automated installation tools. This section provides guidelines 
on how to prepare the software for this type of deployment. 

• Run the installer KS-Workstation-2025.0-64bit.msi. 

• The installer prepares the InstallShield Wizard, and the Welcome window opens. 
Click Next >. 

• The License Agreement window opens. If you accept the terms, select “I accept” 
and click Next >. 

• The Configuration Type window opens. 

• For the Standalone configuration, select the “Standalone configuration” option, click 
Next >, and proceed as follows:  

▪ Select the option “I am an administrator installing the software for someone else”. 
Click Next >. 

▪ If necessary, change the destination folder for the application program files by 
clicking the Change button and specifying the desired location. The default is 
C:\Program Files\Altair Data Analytics. Click Next >. 

▪ The Working Directory window opens. Specify the path for the Working Directory.  

The Working Directory can be parameterized to point to each end user’s 
folder My Documents\Altair or another user-specific folder. For 

example, you can specify the following path in the Working Directory 
field:  

%USERPROFILE%\Documents\Altair 

Note 1: Each user will be able to change the Working Directory at any 
time using the Set Working Directory command in the File menu of the 
installed application. 

Make sure the folder has Read & Write permissions for the intended 
user(s). 

Note 2: If you prefer to use cloud storage, such as OneDrive or Google 
Drive, select a folder with offline access enabled. For example, if you 
choose a folder on OneDrive, right-click the folder in Windows Explorer 
and select option “Always keep on this device".  



 

83 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

The License Configuration window opens. Follow the instructions of Step 9 in 
Section 7.1. Deploying KS Workstation (Standalone) to configure the 
licensing method. 

Click Next > and then click Install in the next page to start the installation. 

• For the Client/Server configuration, select the Client/Server configuration option and 
proceed as follows.  

▪ If necessary, change the destination folder for the application program files by 
clicking the Change button and specifying the desired location. The default is 
C:\Program Files\Altair Data Analytics. Click Next >. 

▪ The KS Server Connection Properties window opens. 

o In the Host field, enter the name or the IP address of the server where 
KS Server is installed. 

o In the Port field, enter the port number to be used by the client to 
connect to KS Server. The default port number is 5470. If you change it, 
make sure the port number entered here is the same as the one 
specified in the KS Server configuration. 

o In the Working Directory field, enter the directory for users’ projects. 

Note 1: This directory path must be a local path with respect to the 
server machine (for example, C:\UserProjects\ for Windows Server 

or /home/userprojects/ for Linux). You can use a network path such 

as \\server1\projects if the Working directory will be on a server 

different from the one that hosts KS Server. The Working Directory 
should have Write permissions for the intended user(s); 

Note 2: The end users can change their Working Directories at any time 
after the installation by using the Set Working Directory command in 
the File menu. 

If each user is supposed to have a separate working directory on the 
server, the Working Directory entry can be parameterized to point to end 
users’ individual folders (e.g., C:\UserProjects\<user_name>). For 

example, specify the following path ensuring to maintain the spaces and 
the case of the letters: 

C:\UserProjects\%USERNAME% 

o If necessary, specify a location for the license files in the License 
Location field. This must be a local path with respect to the server. The 
default is C:\Program Files\Altair Data Analytics\License. 

Click Next > and then click Install to start the installation. 

• The Setup Status window opens. It shows the installation progress. When the 
installation is complete, click Finish. 

 

If the custom settings you programmed during the installation don’t take effect, the 
workaround is to set the custom configuration after deploying the product with default 



 

84 
 © Copyright 2025. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

settings. You can set the mode (client/server or standalone), server name to connect, port 
number, and the Working Directory by replacing an INI file in the KS Workstation program 
folder on every client PC. The configuration file is C:\Program Files\Altair Data 
Analytics\KS Workstation 2025.0.0\bin\KDSConnection.ini  

For example, if you want KS Workstation to connect by default to a specific server and set 
the working directory to D:\KS_Projects, the contents of KDSConnection.ini should 

be as follows: 

<Config> 

<Mode>1</Mode> 

<Location>D:\KS_Projects</Location> 

<Service></Service> 

<User></User> 

<Host>KS_server_name_or_ip_address</Host> 

<Port>5470</Port> 

<Secure>True</Secure> 

</Config> 

In this case, however, the Working Directory will be the same for all users, and they will 
need to change it using the File | Set Working Directory command if they need separate 
working directories.  
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10. Citrix and Remote Desktop Services Environments 

10.1. Citrix 

In a Citrix environment, you will need to deploy the Client/Server configuration of the product. 
KS Workstation can be replicated across as many computers of the Citrix farm as desired, 
while KS Server must be installed on a single server, which may be outside of the farm. 

Here are the steps required to deploy the product in a Citrix environment: 

▪ Make sure all the installation prerequisites listed in Section 5 are met. Allocate the 
necessary disk space on the server and create Working Directories for the users 
following the guidelines in Section 5. 

▪ Follow the instructions in Section 8: Deploying Client/Server Configuration. See also 
Section 9 if you plan to package the Workstation for mass deployment on your Citrix 
farm computers.  

Note: The installation wizard for KS Workstation lets you specify a location for the 
Working Directory. The users will still be able to change their Working Directories at 
any time using the File | Set Working Directory menu command (or the File | 
Connect command). If you want the users to use separate working directories 
(recommended) rather than a shared one, you will need to either parameterize the 
Working Directory in the installation wizard as described at the end of Section 9.2, or 
notify the users after you finish the installation that they should set Working Directory 
to the appropriate locations. 

▪ For configuring the licensing method, see Chapter 14, “License Administration”. 

10.2. Remote Desktop Services 

If you intend to use the product in a multi-user environment where users access the software 
via Windows Remote Desktop Services, you will need to deploy the standalone configuration 
of the product.  

The installation procedures are the same as those described in Section 7, “Deploying 
Standalone Configuration”.  Follow these steps: 

▪ Make sure all the installation prerequisites listed in Section 5 are met.  

▪ Determine whether a separate Working Directory is required for each user or one 
shared Working Directory is required for all users.  

If the users require separate Working Directories, create one for each user and 
assign appropriate read/write permissions for the created directories. After you finish 
the installation, notify the users that they should set Working Directory to the 
appropriate locations. Any user can change his/her working directory at any time after 
the installation by selecting menu commands File | Connect or File | Set Working 
Directory… in the client application.  

▪ Proceed to Section 7, “Deploying Standalone Configuration”. Follow the instructions 
therein, taking into account the following details:  

o If each user requires a separate Working Directory for their projects 
(recommended in most cases), then  
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▪ If necessary, create a new folder for each user of the application. For 
example, create a folder called Altair under the My Documents folder of 
each user profile. Make sure it has read and write permissions for the 
respective users. The Working Directory does not have to be on the 
server that hosts KS Server. It can be a network folder, and users can 
refer to it using a UNC path. Note that KS Server cannot access mapped 
drives in the client/server mode on Windows. 

▪ When specifying the Working Directory in the installation wizard, specify 
any folder that has at least Read permissions for all users.  

▪ After the installation and license activation is done, instruct the users to 
run KS Workstation and set their Working Directories to their respective 
working folders for projects using the File | Set Working Directory menu 
command (or File | Connect command) 

o If all users require a single shared Working Directory for their projects, then  

▪ Create a folder with Read and Write permissions for all users. The 
Working Directory does not have to be on the server that hosts KS 
Server. It can be a network folder, and users can refer to it using a UNC 
path. Note that KS Server cannot access mapped drives in the 
client/server mode on Windows. 

▪ Specify this folder as the Working Directory in the installation wizard (see 
the Custom setup option in Step 7 of Section 7). 

▪ To configure the licensing method, see Chapter 14, “License 
Administration”. 
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12. Advanced Configuration: Optional Runtime Parameters 

Optional runtime parameters for the application can be specified in a special configuration file. 
To set any of the parameters described below, use any text editor to create a new file called 
KDSProvider.conf in the directory that contains the application binaries. The default 

location for the configuration file is: 

• For the standalone configuration of KS Workstation on Windows: 

C:\Program Files\Altair Data Analytics\KS Workstation 2025.0.0\bin 

• For the client/server configuration on Windows Server:  

C:\Program Files\Altair Data Analytics\KS Server 2025.0.0\bin 

• For KS Server on Linux:  

/opt/Altair-Data-Analytics/KS-Server-2025.0/lib 

Since file names on Linux are case-sensitive, make sure that you name the file exactly 
as specified: KDSProvider.conf. 

In the client/server configuration, after modifying KDSProvider.conf, KS Server must be 
restarted for the changes to take effect. 

The following runtime parameters can be specified in KDSProvider.conf:  

• jupyter_path – full path to the jupyter executable (enclosed in double quotes). 

• http.logfile - set to 1 to generate an http log for Knowledge Studio for Apache 

Spark. The log file is created in the %TEMP% directory (the default temporary files 

folder under the current user profile). The default is 0 (the log is not generated). 

• proc – maximum number of threads created by the engine processes (the default is 

“unlimited”). 

• cores – maximum number of CPU cores used (the default is “unlimited”) 

• index_max – maximum size of the temporary index file during data import. 

Determined dynamically by the engine unless the value is set. 0 means “unlimited”. 

• pivot_max – maximum size of the temporary pivot file during data import. 0 means 

“unlimited”. 

• window_max – maximum size of memory window during data import. If the value is 

not set, this does not exceed 3 GB. 0 means “unlimited”. 

• y2k_future – together with y2k_window, defines the default century for Date 

variables. This is ignored if y2k_window has been assigned a value. 

• y2k_window – together with y2k_future, defines the default century for Date 

variables. If no value is assigned, then it is computed from y2k_future as follows: 
y2k_window = current_year + y2k_future - 100 

• wamp.enabled – enables the WAMP service (required for Knowledge Studio for 

Apache Spark). The default value is 1 (enabled). 
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Example configuration in KDSProvider.conf:  

jupyter_path ”C:\ProgramData\miniforge3\Scripts\jupyter.exe” 

http.logfile 1 

proc 4 

cores 2 

index_max 0 

pivot_max 0 

window_max 0 

y2k_future 10 

In this example, since index_max, pivot_max, and window_max are set to 0, data 

import operations will use as much memory as available on the host system. Be careful 
with these settings if you must limit the resource usage in multi-user environments. 

After setting or changing any parameters in KDSProvider.conf, restart KS Server in the 
case of the client/server configuration or KS Workstation in the standalone configuration.  

13. Uninstalling Altair Data Analytics Products 

This section describes the procedure of uninstalling, modifying, or repairing the products 
featured in this guide.  

13.1. Modifying, Repairing, and Removing KS Workstation 

To uninstall KS Workstation, repair the installation, or to add or remove components of the 
software, follow the steps below. 

Note: Uninstalling, modifying, or repairing the software will not delete the users’ projects or 
license files. 

In the Programs and Features list in the Windows Control Panel, select KS Workstation 
2025.0.0.  

▪ To uninstall the software, click Remove or Uninstall.  

▪ To change or modify the installation, click the Change button. 

1. The Welcome window opens. Click Next >. 

2. The Program Maintenance window opens. The description beside each explains 
in detail what it does. Select the appropriate radio button and click Next > to 
continue.  

o If you select Modify, the Custom Setup window opens. A list 
shows you the components that are available, and the 
components that are already installed. See the appropriate 
installation instructions above for the description of the options in 
this window. Select or deselect the components to install or 
uninstall. Click Next >. 
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o The Data Mining Engine Setup Window opens. Change the 
entries as required. See the appropriate installation instructions 
above for the description of the options in this window. Click Next 
> to continue, then click Install.  

o The Setup Status window opens. It shows the installation 
progress. When the maintenance is complete, click Finish. 

OR 

o If you selected Repair, the Ready To Repair the Program window 
opens. Click Install.  

o The Setup Status window opens. The Repair option automatically 
fixes any damaged files or replaces lost files. It begins installing 
the software to the same specifications you selected last time you 
installed. When this process is complete, click Finish. 

OR 

o If you selected Remove, the Remove the Program window 
opens. Clicking the Remove button will uninstall the program. 
When this process is complete, click Finish. 

13.2. Modifying, Repairing, or Removing KS Server for Windows 

To uninstall KS Server, repair or change the installation, follow the steps below. 

Note: Uninstalling, modifying, or repairing the software will not delete the users’ projects or 
license files. 

Open the list of Programs and Features on Windows Server and select KS Server 
2025.0.0. 

▪ To uninstall the software, click Remove or Uninstall. 

▪ If you want to change or modify the software, click the Change button.  

1. The Welcome window opens. Click Next>. 

2. The Program Maintenance window opens. The description beside each 
explains in detail what it does. Select the appropriate radio button and 
click Next>.  

o If you selected Modify, the Custom Setup window opens. A list 
shows you the components that are available, and the 
components that are already installed. See the appropriate 
installation instructions above for the description of the options in 
this window. Select or deselect the components to install or 
uninstall. Click Next>. 

o The Windows Service Setup Window opens. Choose the desired 
options. See the appropriate installation instructions above for the 
description of the options in this window. Click Next> to continue, 
then click Install.  

o The Setup Status window opens. It shows the installation 
progress. When the maintenance is complete, click Finish. 
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OR 

o If you selected Repair, the Ready To Repair the Program window 
opens. Click Install.  

o The Setup Status window opens. The Repair option automatically 
fixes any damaged files or replaces lost files. It begins installing 
the software to the same specifications you selected last time you 
installed. When this process is complete, click Finish. 

OR 

o If you selected Remove, the Remove the Program window 
opens. Clicking the Remove button will uninstall the program. 
When this process is complete, click Finish. 

13.3. Uninstalling KS Server on Linux 

To uninstall KS Server on Linux, follow these steps: 

1. To prevent the interruption of any user’s work by shutting down the service, identify 
the user processes using the command ps –ef | grep kslogin and make 

sure there are no active client sessions.  

2. Shut down the kslogin service and terminate all users’ kslogin processes on the server 
by running the script ks_shutdown from the Altair Data Analytics home directory. 

3. If you used R language integration features on Linux and would like to uninstall the KS 
Library for R and Survival Analysis package, use the commands:  

R CMD REMOVE angoss 

R CMD REMOVE KnowledgeSurvival 

4. If you are planning to reinstall the product or upgrade to a new version, make a 
backup copy of the KS Server licenses. For example, if the product is installed under 
/opt/Altair-Data-Analytics, copy the directory /opt/Altair-Data-Analytics/license/ to a 
backup location. Also, back up the environment and startup scripts and odbc.ini in 
/opt/Altair-Data-Analytics/KS-Server-NN.N, where NN.N is your current version. 

5. Check the KS Server 2025.0 package name using any of the commands  

rpm -qa KS-Server 

rpm -qaiv KS-Server  

The latter provides a detailed description of the package. 

To uninstall KS Server 2025.0, use the command  

 rpm -e <package_name> 

where <package_name> is the exact name reported by the command rpm -qa KS-

Server, for example, KS-Server-2025.0-18151_centos8.x86_64. 

If there are any errors during the uninstall, you may use the command  

rpm -e package_name --noscripts 
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After that you can delete the KS Server home directory. For example,  

rm –rf /opt/Altair-Data-Analytics/KS-Server-2025.0.0  

where X.X is the KS-Server version. You can also delete the parent directory 
/opt/Altair-Data-Analytics after backing up the license folder and any 

configuration files, if necessary. 

6. If you enabled the automatic startup of KS Server as described in Section 8.2.9, 
"Enabling automatic startup", delete the startup script and the related link (if any) from 
the corresponding system directories. The location of the startup scripts depends on 
your operating system (refer to Section 8.2.9 for details). 
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14. Licensing Methods and Configuration 

14.1. Licensing Methods 

Altair Units is a value-based license management system enabling metered usage of an 
entire suite of products. All Altair Data Analytics products have the capability to use a 
single pool of recyclable Altair Units.  

• Managed Altair Licensing 

If your organization is using Managed Altair Licensing, the License Server is hosted 
by Altair, and the application checks out the required license units by contacting the 
license servers in the Altair One cloud via HTTPS. 

See https://help.altair.com/altairone/index.htm for more information on Altair One™. 

• On-premises Altair License Server 

If your organization is using a self-hosted Altair License Server, the application 
checks out the required license units by connecting via TCP to a license server in 
your corporate network or in a cloud managed by your organization. The license 
server is managed by your IT team. 

The Altair License Manager software installation and administration guide is available 
on the Altair Documentation Portal. 

14.2. License Configuration 

This section describes the process of configuring the application host for the licensing 
method you are using. 

If you are using a self-hosted Altair License Server, the instructions below assume that it 
is already installed on a server in your network, and that you have the name or IP 
address of the license server at hand. 

There are three configurations of Knowledge Studio and Knowledge Seeker: 

1. Standalone  

2. Client/Server for Windows Server 

3. Client/Server for Linux 

14.2.1. Environment Variables in the Standalone Configuration 

From the Windows Control Panel, select System and click Advanced System 
Properties. If you have no access to Advanced System Properties, click on the 
Windows Start button and start typing "environment", then select “Edit environment 
variables for your account”. 

https://altair.com/altair-units
https://help.altair.com/altairone/index.htm
https://community.altair.com/
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In the Advanced tab of the System Properties dialog, click the Environment 
Variables button.  
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Click the New button in the System variables section or in the User variables 
section, depending on whether you are activating the product for all users on this 
machine or only the user ID currently logged in. 

 

• Set Variable name to ALTAIR_LICENSE_PATH  

• For the Variable value field:  

o If you are using Altair License Server, enter its address and port 
number. The format is:  NNNN@<server_name_or_IP_address>, 
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where NNNN is the port number (6200 by default), and the second 
part is the Altair License Server host name or IP address. For 
example: 6200@server1 

o If you are using Managed Altair Licensing, set the value to false 

Click OK to create the variable. 

Click the New button in the same section as ALTAIR_LICENSE_PATH. 

 

• Set Variable name to ALM_HHWU  

• To use Managed Altair Licensing, set the value of ALM_HHWU to True. 
Otherwise, set it to False.   

Click OK in all dialogs to save the changes and exit the Advanced System 
Properties dialog.  

Start the KS Workstation application.  

The Select Product window will prompt you to select the desired product (feature set 
to be enabled). 

 

Select the desired product and click Launch. 
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14.2.2. Environment Variables for KS Server on Windows 

From the Windows Server Control Panel, select System and click Advanced 
System Properties.  

 

In the Advanced tab of the System Properties dialog, click the Environment 
Variables button.  
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Click the New button in the System variables section. 

 

• Set Variable name to ALTAIR_LICENSE_PATH  

• For the Variable value field:  

o If you are using Altair License Server, enter its address and port 
number. The format is NNNN@<server_name_or_IP_address>, 
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where NNNN is the port number (6200 by default), and the second 
part is the Altair License Server host name or IP address. For 
example, 6200@server1. 

o If you are using Managed Altair Licensing, set the value to False 

Click OK to create the variable. 

Click the New button in the System variables section. 

 

• Set Variable name to ALM_HHWU  

• To use Managed Altair Licensing, set the value of ALM_HHWU to True. 
Otherwise, set it to False.   

Click OK in all dialogs to save the changes and exit the Advanced System 
Properties dialog. 

Start the KS Workstation application on any client machine. 

Connect to KS Server. The Product Selection window will prompt you to select the 
desired product.  

 

Select the desired product and click Launch. 
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14.2.3. Environment Variables for KS Server on Linux 

Define the environment variables ALTAIR_LICENSE_PATH and ALM_HHWU in the 
KS Server startup script ks_start as described below. For information about 
ks_start, see Section 8.2.5, “Configuring KS Server on Linux”. 

1. If you are using self-hosted Altair License Server:  

• Set the value of ALTAIR_LICENSE_PATH to the address of the Altair 
License Server. The format is:  NNNN@<server_name_or_IP_address>, 
where NNNN is the port number (6200 by default), and the second part is 
the Altair License Server host name of IP address. For example: 

export ALTAIR_LICENSE_PATH=6200@server1 

• Set the value of ALM_HHWU to false:  

export ALM_HHWU=false 

2. To use Managed Altair Licensing: 

• Set the value of ALM_HHWU to true 

export ALM_HHWU=true 

Save the changes in ks_start and restart KS Server using any of the methods 
described in Sections 8.2.5 and 8.2.6.  

Start KS Workstation on any client machine and connect to KS Server. The Product 
Selection window will prompt you to select the desired product (feature set).  
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Select the desired product and click Launch. 

14.2.4. Machine Authorization for Managed Altair Licensing 

This section describes how to authorize the application host machine(s) for 
Managed Altair Licensing, where the license server is hosted in the Altair cloud. 
This step is not required if you are using a self-hosted Altair License Server. 

Standalone configuration for a single user: 

1. If you have not registered on the AltairOne portal yet, ask a user with Altair 
license admin role at your company to add you as a user at 
https://AltairOne.com. You will receive an email from Altair with a link to 
activate your AltairOne account. Click the activation link in your email and 
register on the AltairOne portal. 

2. Open the file browser and navigate to the folder C:\Program Files\Altair 
Data Analytics\KS Workstation 2025.0.0\security 

 

3. Double-click on the almutil_gui. The Altair License Utility window opens: 

 

https://altairone.com/
https://altairone.com/
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4. Go to the Managed Licensing tab of Altair License Utility window: 

 

5. Specify your AltairOne credentials: your email address and password that 
you used to register at the AltairOne portal. Click Sign In.  

Alternatively, if you are not registered at the AltairOne portal and 
received an authorization code an Altair license admin user at your 
company, click Use Auth Code, specify the authorization code received 
from this user and click Authorize. 

You will get the message: “Successfully authorized this machine”. Click OK. 

 

Client/Server configuration or Standalone configuration for multiuser access: 

1. If you have not registered yet on the AltairOne portal, ask a user with Altair 
license admin role at your company to add you as a user at 
https://AltairOne.com. You will receive an email from Altair with a link to 
activate your Altair One account. Click the activation link in your email and 
register on the Altair One portal. 

2. Log on to https://altairone.com/Dashboard. In the Manage Account section 
of the Altair One Dashboard page, click Managed Licenses, as shown 
below. 

https://altairone.com/
https://altairone.com/
https://altairone.com/
https://altairone.com/
https://altairone.com/Dashboard
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3. In the left pane, click User Profile: 

 

4. Click Authorized Machines in the User Profile page: 

 

5. In the Authorized Machines page, click Generate Auth Code at the top right 
corner: 
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6. This will generate an authorization code to authorize a machine for the Altair 
license. Copy the code to the clipboard. Note: The code is valid for 15 
minutes, so you must perform the next 7 steps within 15 minutes of 
generating the code. 

 

7. After copying the code:  

• For the Standalone configuration on Windows: run Command Prompt as 
administrator and change to the folder C:\Program Files\Altair 
Data Analytics\KS Workstation 2025.0.0\security 

• For the Client/Server configuration on Windows: run Command Prompt as 
administrator and change to the folder C:\Program Files\Altair 
Data Analytics\KS Server 2025.0.0\security  

• For the client/server configuration on Linux: Change to the directory  
/usr/local/altair/licensing15.5/bin/, which contains almutil. If 

you cannot find almutil on your Linux system, please contact Altair Customer 
Support. 

8. Run the following command as administrator, where NNNN is the 
authorization code generated at the previous step: 

almutil -a1auth -system -code NNNNN 

The almutil tool can also be used to test the connectivity with the license 
servers in the Altair One cloud and configure proxy settings. Run almutil 

to view the detailed information on the usage and all available options. 

9. Once you get the message that the machine was successfully authorized, 
restart the application (KS Server service for the client/server configuration; 
KS Workstation for the Standalone configuration). 
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15. Contacting Customer Support 

Altair Customer Support website: https://community.altair.com/community  

To report issues with the software or ask questions regarding the product features, please contact 
Customer Support via email or telephone: 

• Telephone: 1-888-715-7391 (toll-free within North America) or 1-416-593-2417 

• Data Analytics Customer Support e-mail: dasupport@altair.com  

We welcome your suggestions on how to make our application easier to use and understand. 
Please send your comments and suggestions to dasupport@altair.com. 

Join our online community of experts and users to share insights, collaborate with colleagues and 
find more ways to take full advantage of your product: https://altair.com/knowledge-studio-user-
group 

 

 

https://community.altair.com/community
mailto:dasupport@altair.com
mailto:dasupport@altair.com
https://altair.com/knowledge-studio-user-group
https://altair.com/knowledge-studio-user-group
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About Altair | Altair Data Analytics 

Altair is a global leader in delivering advanced 
analytics to businesses looking to improve 
performance across risk, marketing and sales. 

Altair removes the complexity inherent with 
predictive analytics and machine learning with 
a platform that is intuitive to use and rich in 
features. It is designed so that Data Scientists 
and Data Citizens alike can build models used 
to help solve business problems. 

https://www.altair.com/  
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